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Welcome to the latest edition of my monthly Final Cut Pro newsletter. This is the May, 2006, edition.
The goal of this newsletter is to provide information helpful to the professional user of Final
Cut Pro. This newsletter publishes each month. Past issues are not archived. However, key
articles are posted on my website for your reference. All software references are to Final Cut
Pro 5 unless otherwise noted.
Please invite your friends to visit my website -- www.larryjordan.biz. We now have over 100 tutorials to help
you get the most out of Final Cut!
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Introducing Edit Well -- the Interactive Newsletter for Final Cut Studio
We produced our first test issue in January. Now, after six months of planning and polishing, we have
partnered with Peachpit Press to create: Edit Well.
Each month's issue is delivered on-line, in PDF format, and includes articles, audio interviews, video

tutorials and lots and lots of tips and techniques for the serious Final Cut user. I have the pleasure of being
the Editor of this brand-new, on-line publication.
Best of all, the first issue is FREE!
I strongly encourage you to go to www.editwell.com and sign-up to receive the first issue. In it, you'll find
articles from Tom Wolsky, Philip Hodgetts, Kevin Monahan, Mark Spencer, Bruce Nazarian and myself.
Stories and information you won't find anywhere else -- including this website -- presented in a visual,
entertaining, and knowledgeble way.
Plus, the first issue features an extensive audio interview with Paul Saccone, product marketing manager
for Final Cut Studio, from the floor of NAB, as well as a video tutorial showing you specific techniques you
can use to optimize your computer system for Final Cut.
The premiere issue is scheduled to release May 12, with new issues appearing monthly thereafter. The
introductory subscription price for 12 issues is $59.99.
Click here to learn more (www.editwell.com) -- and sign up for your free issue.

Changes to this newsletter
The benefit to editing a newsletter that has a budget is that I can hire the best Final Cut writers in the world
to create a truly great publication. This is a real treat and I'm enjoying the opportunity.
Just because I am launching Edit Well doesn't mean this newsletter is going away. It isn't. But it is
changing. Edit Well is subscription-based and each issue features several Final Cut experts sharing their
knowledge about the different applications in Final Cut Studio. My feeling is that the Final Cut community
will support a paid newsletter that delivers on its promise to provide timely, authoritative, well-written
information you can use to improve your skills.
This newsletter will continue to be written solely by me. It will continue it's tradition of providing tips,
techniques, polls and commentary, but it will focus on reader mail and comments. It's my hope that these
two publications can work hand-in-hand, with Edit Well presenting the in-depth articles, analysis, audio
interviews, and video demos; with this newsletter allowing time for follow-up discussion.
[ Go top ]

Commentary: NAB 2006
By now you've read all the press coverage of the event and discovered that Apple did not announce a new
version of Final Cut -- though they did spend a lot of time showing their latest version, 5.1, running on a
MacBook Pro laptop.
While at NAB, I created two audio reports that were posted to my website:

●
●

Tuesday - featuring excerpts of the Paul Saccone interview and thoughts on the show
Friday - featuring different Saccone excerpts and highlights of the Super User Group meeting -including a seriously-over-excited Michael Horton describing the crowd.

Click here to listen to Tuesday's report -- Quicktime movie, 3.3 MB -- 5:57 minutes. (Takes a minute to
load.)
Click here to listen to Friday's report -- Quicktime movie, 6.2 MB -- 9:02 minutes. (Takes a minute to load.)
Philip Hodgetts wrote a great analysis of NAB trends for Edit Well -- remember that first issue is free -- but I
wanted to chime in with my own two cents, because I saw four trends that are worthy of mention:
1.
2.
3.
4.

Proliferating video formats
CRT monitors being replaced by LCD displays
Tapeless acquisition
Tremendous vitality in the FCP community

Proliferating Video Formats
I walked past a camera manufacturer's booth that had a sign hung over their camera saying "Shoots 21
different formats!" as if that was something to be proud of.
Do you remember the old days when we struggled to deal with NTSC and PAL? The new Panasonic P2
camera shoots 81 different combinations of video formats, frame sizes, and frame rates! That's just plain
way too many.
This last weekend, I spent an hour and a half on the phone with a client helping them figure out how to
integrate pictures from a Sony and Panasonic camera. The brave new world into which we are rapidly
plummeting is one where no two cameras seem to speak the same language.
As video editors, we are rapidly approaching the point where we are no longer bound by our creative ideas,
but find ourselves restrained by how fast our editing software can be upgraded to support the latest
incompatible camera format.
I'm all for "new and improved," but right now I'm feeling like technology is running amok. Do we REALLY
need all these different formats? Are any of the manufacturers taking notes on the HD-DVD / Blu-Ray
mess? I mean, wouldn't it be nice to pick a camera for the quality of its images without having to worry
about whether it's possible to edit those images afterward?
Based on what I saw at NAB, the answer is a resounding: nope!
Sigh...

LCD Monitors are Taking Over
I met with a Panasonic rep in their booth at NAB who gets extra points for honesty and forthrightness. I
have been troubled for a while with the trend of replacing CRT monitors with LCD monitors. So, I asked
him why this was happening.

He told me that there is only one manufacturing plant in the world who is making the phosphor-coated
glass necessary for video monitors. Consequently, they are scrambling to convert to LCD.
The problems with LCD monitors are that they don't show accurate color -- at least for a price that mere
mortals can afford; and they don't show interlacing. (Interlacing is that wild flickering you often see on still
frames or still images that shows up on your TV set, but never on your computer monitor.)
Based on a quick survey, the only manufacturer that currently sells CRT monitors is JVC -- their TMH150G monitor is VERY nice, and affordable). Sony and Panasonic are both exclusively LCD.
If you plan on working in an interlaced format -- whether NTSC, PAL, or 1080i -- you need a monitor that
displays interlacing. That excludes LCDs. Take a look at the JVC and see if it meets your needs.

Tapeless Acquisition
Just before I left for NAB, Chris Hayner sent me the following:
If I was to use either Firestore or DV Rack, how would I go about archiving at the end. Since
there wouldn't be a batch list or physical tapes to recapture from? Would I have to transfer
the files to a miniDV tape and some how make a batch list later? Any thoughts?
Chris, that is the $64,000 question!
Whether we like it or not, camera manufacturers are moving to tapeless acquisition because they like the
flexibility and weight-savings that tapeless provides. What they haven't done is figure out how we are
supposed to archive all the footage we are collecting.
Copying your footage back to MiniDV tape only works if you are shooting DV. (By the way, be sure to use
tape specifically labeled to support HDV -- MiniDV tape may not have the necessary bandwidth to support
HDV.)
I am not a fan of archiving projects on hard disks. My garage is full of hard disks that no longer connect to
my computer. Hard disks are great for short- and medium-term storage, but not long-term.
At the show, Rimage (www.rimage.com) was showing a Macintosh-based archiving system in conjunction
with its partner, Perennity (www.perennitysoft.com). This system backed-up data to optical disk and
allowed files to span multiple disks. Perennity provides media management and cataloging. The big benefit
was that files are stored in native format, so they can be easily located and copied from optical media to
your hard drive.
Quantum (www.quantum.com) was showing its SDLT 600A tape storage system, also Mac-based. Each
DLT tape stores 300 GB of data and backs up at the rate of 36 MB per second. The big benefit was that
Quantum has been around since forever, as has the DLT format.
However, both systems were pricey -- hovering around the $8,000 mark, excluding media. These prices
make it hard for the individual editor, or small project studio, to afford adequate backup.

FCP is Everywhere

In spite of my grumbling, there was lots of good news -- led by Apple's announcement that they have over
500,000 FCP users around the world. Plus, it seemed that everywhere I went on the show floor, Final Cut
was demoing new products.
This tremendous vitality in Final Cut is vastly reassuring as we make the transition into High-Def. FCP is
not relegated to some small corner, but is, instead, front-and-center as NLE editor of choice. This means
that we can look forward to more choices and more products that support Final Cut, rather than looking
nervously over our shoulder waiting for the other shoe to drop.
I'm reminded of that ancient Chinese curse: "May you live in interesting times." Whew! They just can't get
more interesting than this.
[ Go top ]

Update tidbit
If you are waiting to upgrade to OS 10.4 based on my opinions, I am now satisfied that upgrading to OS
10.4.6 is fine fo rrunning FCP. I would strongly urge, however, that if you are running FCP HD, that you
remain on OS 10.3. Make sure, if you are running any capture cards or RAIDs that they are approved for
the OS version to which you plan to upgrade. Make sure of this BEFORE you upgrade your system.
Also, while the jury is still out on FCP 5.1, I am not hearing any major complaints. I've ordered my copy, but
my disks have not arrived yet.

Notable Quote
Dave Muehsam, a long-time reader in Pennsylvania, writes:
Perusing one of my old tractor books the other evening, I found a 50 year-old quote that
nicely sums up your philosophy on software upgrades. The John Deere Company joined
forces with their long-time rival McCormick Deering Company in trying to persuade farmers
to give up their horses in favor of tractors. As a kind of compromise point between the
farmers and the techo-geeks the following saying was born: "Be not the first by which the
new is tried, nor the last to lay the old aside." Apropos.

Larry Presents His Final Cut Seminars On-line!
Since we finished our Winter Seminar Tour, I've had a lot of requests for more training from around the
world. Our staff is currently working on two seminar tours -- one a six-city tour in Australia and the other a
twelve-city tour in North America, both later this year.
However, our Winter Tour didn't begin to meet the need. So, I'm delighted to announce that we are now
offering web-based seminars!

Our first event is Monday, May 22, and shows you how to optimize your system for Final Cut. This hourand-a-half event allows you to watch, learn, AND ask questions.
We are offering it twice: 10:00 AM California PDT and 6:00 PM PDT.
This is very cool stuff -- world-class training brought directly to your web browser. We've been testing this
for the last month and I'm really excited to be working with this new technology.
To learn more about the agenda, and to register, click here: www.larryjordan.biz/sem/webinar.html
[ Go top ]

Article: Improving the Look of Your Graphics and Text
Video is really, really good at showing motion and emotion. It's not so good at displaying text.
One of the discouraging facts of life is that we create all these great graphics on our computers only to see
them destroyed when they get transfered to video. (Well, OK, maybe not destroyed, but really, really
different.)
Is there anything we can do to change this situation? Well, um, no. But, there are things you can do to
improve the look of your graphics and text when they are displayed on video. And that's what this
technique is about.
First, I'll explain how video and computers are different, then wrap up with a series of specific suggestions
you can use to improve the look of your text.

In the beginning
Video was invented about forty years before computers; which means that computers were able to improve
on the lessons we learned during the development of video. Because of this, there are six major
differences between graphics on video and graphics on the computer. Keeping these in mind will help you
improve the look of your text.
These seven differences are:
●
●
●
●
●
●
●

Video is fixed resolution, computer resolution varies
Video displays interlaced images, computers display progressive images
Video gamma is different from computer gamma
Video white is grayer than computer white
Video uses YCrCb colors, which are more restrictive than the computer's RGB colors
Video colors are not as precise as computer colors
Video pixels are rectangular, the computer's are square

Let's take a look at each of these and see what problems they cause.

Fixed Resolution

Regardless of the size of our video monitor, all SD video is 720 x 480 pixels (720 x 486 for you broadcast
types and 720 x 576 for PAL). If you do the math, this works out to about 0.3 megapixels -- a far cry from
even a cheap digital still camera's 4, 6 or 8 megapixels.
This limited number of pixels means that your image quality varies by screen size. The bigger the screen,
the grainier the image. Also, because there are so few pixels, lines that are nearly horizontal or vertical will
show serious "stair-stepping," in a way that the same line on the computer will not.
This means that, graphically, we need to avoid using very fine detail or lots of thin or swirly lines. Video just
doesn't have enough pixels to draw the image accurately.

Interlacing
NTSC, PAL, and some HD formats are interlaced. This means that while we see many complete images
each second, each image, or field, is not complete in and of itself. Instead, the video monitor displays the
image in two parts -- first all the odd lines of the image, then all the even lines.
This means that in the US, we are not seeing 30 images per second, but, instead, are seeing 60 halfimages per second. These "half-images" are called "fields." (PAL displays 25 images per second,
composed of 50 half-images, or fields.) Essentially, interlacing means that the vertical resolution of our
image is instantly cut in half, because we are only seeing 1/2 the image at any given instant.
The result of using fields is that we have even less image data to work with. Thin lines flicker wildly
because they are in one field, and not the other. Curved lines look even more stair-stepped. A moving
object has weird horizontal lines radiating out from each edge that you can see on the computer, but not on
the video monitor.

FCP suppresses displaying interlace lines UNLESS you show your image at 100% size in either the
Canvas or Viewer. This picture illustrates what interlacing looks like; the red arrow points to the horizontal
interlace lines.

Video gamma is different from computer gamma

This was illustrated in a message from Joe Sphinx:
Hey Larry, this sounds like a stupid problem, but I'm having an FCP 5 problem. I captured
hdcam material via decklink card in FCP 5 at dv resolution for offline. then wanted to export
stills from the timeline as uncompressed tiffs with quicktime conversion. when having done
this, pics come out darker than what is represented on timeline and external monitor. Any
ideas around this?
Larry replies: Yup. The computer does not display the same color levels as video. Each use a different
gamma (or mid-tone gray) setting. The standard gamma for the Mac is 1.8. The standard gamma for video
is 2.2, which is darker than 1.8. You can compensate by load your stills into PhotoShop and setting the midtone gray setting in Levels to 1.2. However, don't change the gamma setting on stills you want to reimport
into your FCP project, or they won't match your existing footage.

TV White is Actually Gray
Video was invented in an analog world -- computers are digital. Consequently, they don't use the same
black and white points.
Digital black is displayed at 0% on FCP's Waveform monitor. Digital white is displayed at 109%. (Here's a
good article on how to read scopes.)
However, digital black to white is too great a range for analog video, which include broadcast and DVD
duplication. When you are creating graphics or text for video, set your black level to zero on the Waveform
monitor, but keep your white level to 92% (235 in PhotoShop's color picker).
This is called keeping your white levels "broadcast safe." You can clamp your white levels to the correct
value by applying the Broadcast Safe filter (Effects > Video Filters > Color Correction > Broadcast
Safe).

You can tell if your white levels are too hot by selecting either the Canvas or the Viewer and choosing View
> Range Check > Excess Luma. If you see a yellow warning triangle, your white levels are too hot. A
green check-mark means they are OK.
You can see this, as well, by looking at your video on the Waveform monitor. If any white pixels are above
the 100% White line, your white levels are too hot.
Excess white levels will cause white text to shimmer, tear, or break-up. It can also cause a buzz in the
audio. It also means that your video will be rejected for broadcast, as well as by most cable outlets and
duplication facilities. You'll need to reduce your white levels and re-output.
Shooting, editing, and outputting on DV -- since that is all digital -- does not require clamping, or restricting,
your white levels to 100%. However, if you then compress your file for DVD, you'll find that the process of
compression converts your images into a broadcast safe format, which may, or may not, give you the

results you expected.

Video can't display as many colors as your computer
Computers use an RGB color space, digital video uses YCrCb (analog video uses YUV). Both video color
spaces are more restrictive than the computer. In other words, you can easily create colors on the
computer that can't be displayed in video. Saturated yellows and blues come instantly to mind.

You can tell if your chroma levels are too hot by selecting either the Canvas or the Viewer and choosing
View > Range Check > Excess Chroma. If you see a yellow warning triangle, your white levels are too
hot. A green check-mark means they are OK. (These symbols look remarkably similar to the white level
symbols I just discussed -- that's because they are.)

You can see this, as well, by looking at your video on the Vectorscope. If you connect the tops of the six
targets, representing the six primary and secondary colors, if any white pixels exceed the boundaries of
that rectangle, your chroma levels are too hot.
Excess chroma levels, like excess white levels, will cause colors to shimmer, tear, or break-up. It can also
cause a buzz in the audio. It also means that your video will be rejected for broadcast, as well as by most
cable outlets and duplication facilities. You'll need to reduce your white levels and re-output.

Video colors are not as precise as computer colors

Through a process called "color-sampling," the colors of adjacent video pixels are averaged to reduce file
size. The problem with color sampling is that the quality of your image is often degraded. Worse, it gets
harder to pull a clean chroma-key, or to do good color correction.
Here are two articles on my website that describe this problem in more detail:
●
●

DV, Color Space and Chroma-keying, by Larry Jordan
What is Color Sampling, by Graeme Nattress

The key issue with color sampling is that we don't have the same precision with color in video that we do
with the computer. This is, generally, not an issue when we are shooting pictures, but becomes a
significant concern when doing effects compositing, color correction, chroma-key, or adding text.

Video pixels are rectangles
Of all the problems between computers and video, this one causes the most confusion. While most HighDef video uses square pixels, NTSC and PAL do not. Both are rectangles, an NTSC pixel is tall and thin,
while a PAL rectangle is short and fat.
This means that when we create graphics on our computer, we sometimes need to take this into account. I
say sometimes because Final Cut is inconsistent in how it deals with imported graphics. Here's the scoop:
if you are creating single layer graphics, such as scans or text supers, to import into FCP, you must adjust
your image size for the difference between square and rectangular pixels. If you are creating multi-layer
PhotoShop graphics, you don't.
Here's a table that will help you better plan your images. This assumes you want all images imported fullscreen with no moves on the image. (These numbers came from Apple's web site.)
Video pixel dimensions
Video format

Single layer

Multi-layer

Video image

DV (4:3)

720 x 540

720 x 480

720 x 480

DV (16:9)

853 x 480

720 x 480

720 x 480

SD (4:3)

720 x 547

720 x 486

720 x 486

SD (16:9)

853 x 486

720 x 486

720 x 486

PAL (4:3)

768 x 576

720 x 576

720 x 576

PAL (16:9)

1024 x 576

720 x 576

720 x 576

DVD (4:3)

720 x 534

720 x 534

720 x 480

DVD (16:9)

853 x 480

853 x 480

720 x 480

Sigh... It's enough to drive you completely nuts.
By the way, if you want to create an SD image for camera moves, a size that I recommend is 1800 x 1350
x 72. This works great for moves on scanned images.

HDV is a special case

Joe Ruscitto writes:
I would like to ask you some further questions concerning HDV. I still am somewhat
confused, about still photographs that are going to be imported into an HDV project. What
am I resizing these pictures to? Is it 1440x 1080 or is 1920 x 1080. These stills have been
scanned at a high resolution so they do need to be resized for FCP. Are we also dealing with
square and non-square pixels?
The other question concerns some if the footage was shot DV 16x9. Should I be capturing
using the NTSC DV anamorphic codec. That is somewhat confusing to me. How will this cut
together in the HDV sequence. The aspect ratio will still be 720 X480. Does this footage
have to be scaled up to be compatible with the HDV footage in the sequence?
Larry replies: I TOLD you this was a mess!
●

●
●

HDV uses square pixels. If you want to import an image into an HDV sequence, size it to 1920 x
1080 x 72
To capture DV 16x9, select the ""DV NTSC - Anamorphic" Easy Setup in FCP 5
To combine DV and HDV footage on the same timeline, you need to decide if you want to output
HDV or DV. Whichever you decide, the other format will need to render before it will play back. Uprezing DV footage to HDV will NOT make it look better.

Tips to Improve your Text
So, given all these constraints, it's a wonder we can create anything on our computers that displays
properly on video. But, we can. And here are some tips that can help.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Avoid lines thinner than 4 pixels, they will flicker
Avoid lines that are almost horizontal or almost vertical, they will stair-step
Avoid fancy, curvy fonts like Harrington, Chancery, or Savoye
Avoid fonts with very thin bars or serifs, such as Engravers, Baskerville, or Modern
Avoid point sizes smaller than 24 points
Avoid saturated colors, use the Vectorscope if you are unsure
Avoid whites brighter than 92% (235 in PhotoShop)
Always use drop shadows on any text you want your viewers to read
Always keep any text you want viewers to read inside Title Safe
Keep text on screen long enough for you to read it three times.

Remember that text always looks better on your computer screen than it does on a TV set. So, if you can't
read it inside Final Cut, your viewers won't be able to read it either.

Special Pricing on all Final Cut Training DVDs
I am delighted to announce that we are now offering special $99 pricing on all our Final Cut training DVDs
for the month of May. This is a savings of $50 per title!
●
●

Essential Editing - $99 (click for contents)
Essential Effects - $99 (click for contents)

●

Beyond the Basics - $99 (click for contents)

Thanks to a special arrangement with Lynda.com, the publisher of all our DVD titles, we are able to offer
these prices through the end of May. If you've been interested in taking your Final Cut skills to the next
level, this is a great time to start -- and you save money!
Click here to go to our store to learn more (www.larryjordan.biz/store/index.html)
[ Go top ]

Last month's poll -- Least used features
Last month, I tried something a little different -- asking you what your least used features of Final Cut were.
With almost 400 responses, XML export led the pack, or whatever the analogy is when you do something
less than anything else. Um, anyway, here are the results:

The top (bottom?) six features are:
1.
2.
3.
4.
5.
6.

XML Export
External control surfaces
Changing clip timecode
Customizing the keyboard
Customizing buttons
DV Start/Stop detection

Why, who knew such disuse lurked amidst all the menus of Final Cut?
Thanks to everyone for responding -- I always enjoy looking over these results. If you want to see the
results of past surveys, click here.

This month's poll - Wha' cha' gonna buy?
With Apple's transition to Intel processors, plus the increased speed they provide, this month I'm interested
in learning what's the next computer you plan to buy, that is, when the time comes to upgrade your Final
Cut system.
Not all these systems have been announced, so don't call me asking where to buy one.
I'd like to learn how many of you plan to edit on laptops -- which are more than fast enough to edit DV -versus tower systems. And with even the lower-cost systems more than fast enough to edit video, I'm
interested in learning whether there is a significant interest in using the entry-level systems for editing.
Here's what the survey looks like:

Click here to vote in this month's poll: http://www.pollmonkey.com/p.asp?U=7265528827
[ Go top ]

Warning: Text size in Motion differs from Final Cut
This warning started innocently enough when a client handed me a puzzle: Text created in Motion does not
match the same text created in Final Cut.
Let me prove this with a test.

Open Motion and create a text field. Enter some text, say "Text Sizing." Set it to Eurostyle - Bold - 48
points, leave tracking and line spacing set to 0. Make a point to center the text in the middle of the Motion
project.
Save your Motion project, so you can open it in Final Cut.

Now, open Final Cut Pro (I'm using version 5.0.4) and create a text clip with the exact same specs. (I made
it yellow so you can see it easily in this comparison.) Make a point to place the clip at an origin of 0,0 -dead center in the frame.

Superimpose the two clips and, voilá, the two text clips DON'T match! Not only are the fonts different sizes,
but they are in different parts of the frame.
This flies in the face of everything I ever understood about the commonality of fonts on the Macintosh.
Fonts have always matched between applications -- but, somehow, between these two, they don't. Final
Cut fonts are both smaller and lower.
Be forewarned.
[ Go top ]

Technique: Anchor Point tricks
This next tip was sparked by an idea suggested in "Advanced Color Correction and Effects in Final Cut Pro
5," written by Alexis Van Hurkman and DigitalFilm Tree.
Have you ever wondered what the Anchor Point does in the Motion tab? Well, I always thought of this as
the point around which an image revolves. While true, the anchor point actually does a lot more -- it is the
point around which "all motion parameter transformations are centered."
Hmmm..., I wondered, what that means in English?
Well, let's play for a few minutes and discover what this can do.

I have created a rectangular shape and colored it tan because I was tired of white. I then edited it to the
Timeline and double-clicked it to load it into the Viewer. Then, I selected the Canvas and, from the View
menu in the Canvas, chose "Image + Wireframe." (Yes, there are other ways to do this, I just wanted to
show you something different.)

Click the Motion tab and change the setting in the LEFT anchor box to -200.

Notice that a new white dot appears in the Canvas with a line connecting it to the center of your image.
This new dot is the anchor point. You can grab the anchor point with your Arrow tool and drag it anywhere
you'd like. (If you don't see the white dot, be sure the clip is selected in the Timeline.
When you are done dragging, reset the Anchor boxes so they read -200, 0. Make sure the clip is still
selected in the Timeline.

To see the kinds of effects you can create by changing the anchor point, move the hands of the rotation
clock. Notice that your image is rotating around the anchor point. Cool, but not life-changing.

However, watch what happens when you drag the Scale slider -- notice that the image scales from it's

original position at the center and gradually recedes into the anchor point? This is VERY cool, because
simply changing the location of the anchor point means any image can disappear into any point in the
frame by only two keyframes to change the scale.

For extra credit, watch what happens when you change both rotation and scale at the same time.
Very cool -- and very easy!
[ Go top ]

Reader Mail
Reader mail is enormous this month, so I've moved it to a separate page. Click here to read it.)

Wrap-up
Well, that wraps it up for this issue. The next issue will be released after NAB, so I can cover whatever
happens there. We've got some exciting stuff planned for the next few months and I'm looking forward to
telling you about it.
Please register for one of our on-line seminars - espeically if you are frustarted with the
speed or performance of your computer system. The first one is May 22.

Or, if you want to jump-start your Final Cut skills, save $50 by buying one of our DVD titles
before May 30. Click here for our store.
Finally, remember to share your opinions in our monthly poll. Click here to vote: http://www.
pollmonkey.com/p.asp?U=7265528827
I'm grateful for all your comments and questions. I love hearing from you because when you share your
ideas and suggestions, we all learn.
Thanks and edit well.

Larry
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New FCP User Group in Sweden
HDV and chroma-keying
Cinema tools question
PAL and color space
FireWire to monitor drop-outs
Audio normalization
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Well, we have an unusually large mail bag this month - so large, it needs it's own page. So, let's plunge
right in.

New FCP User Group in Sweden
Erik Lindahl writes:
I'd just like to announce that Final Cut Pro User Group Sweden (FCPUG.se) has just
become an official Apple MUG. We're the only Final Cut User Group currently active in

Go

Sweden.
Final Cut Pro User Group Sweden (FCPUG.se) is a community for creative enthusiasts as
well as people in the film production industry. Our goal is to as a group increase our
knowledge in the thing we love - to produce film and other moving media.
As Sweden's only Final Cut Pro forum our main interest is surrounding post-production with
Final Cut in the center. The goal is however to cover as much of the post-work as possible,
including editing, compositing/visual effects, compression, DVD-authoring and delivery.
We're also keen on having non-pros in our community. Of course we also see the whole
area of video/filmproduction with burning interest as well.
In the long run we want to build a knowledge-bank through attracting both the technical and
creative brains to our community.
Our website is located at: http://www.fcpug.se
It currently features a large online forum with news-coverage and other online-related items
to come to shortly Real-life meetings will be held at least twice a year.
Regards,
Erik Lindahl
Founder FCPUG.se
Larry replies: Welcome! And thanks for letting me know.
[ Go top ]

HDV and Chroma-keying
Matt Davis writes:
In last month's newsletter, you talked about the poor quality of chroma in HDV, I would agree
with you, but I wouldn't go as far as to say that one should never shoot HDV in a chroma-key
studio.
I've achieved better results than DV by shooting HDV, then scaling it down to a SD
DVCPRO-50 timeline. The low resolution of HDV chroma is smoothed out by the scaling,
and the 4:2:2 color space of DVCPRO-50 preserves that info.
Okay, so that may not be 'HD' but HDV has a lot to offer the Standard Def world. :)
Larry replies: Now that's an interesting way to get more color information into an image.
By the way, Serious Magic was showing it's PC-based chroma-keyer working on a MacBook Pro at NAB
using Boot Camp; which was truly amazing. And Ultimatte was showing how it's keyer can pull clean keys
even from DV footage.

[ Go top ]

Cinema Tools Question
David Ransley writes:
I have just finished creating a Neg Cut list using Cinema Tools and I ran into a problem that I
did not foresee.
From the edit I created five EDLs (reels 1 to 5) and I thought that I would be able to select
them as a group from Cinema Tools. Unfortunately I was not able to do this and I had to
combine the EDLs into one.
Is it possible to have Cinema Tools select a group of EDLs and create one cut list? It can be
done on Avid and with other Neg cut programs.
Larry replies: I have no idea -- but if a reader knows the answer, I'm happy to pass it along.
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PAL and color space
Aaron Eoff, of Nu Vue Media, writes:
Larry I enjoyed your article on HDV. In fact I've started a collection of articles from various
sources about HDV. One thing that I've seen suggested a lot is to shoot in PAL or 50i and
then slow down audio by 4%. Not only do you get a 24p look but also the color space is
preserved at 4.2.2. I don't have my folder in front of me right now so some of what I'm saying
may not be accurate. So what do you think of this workflow?
Larry replies: Slowing down video has NO impact on color sampling. Shooting HDV creates a 4:2:0 color
sample, which contains significantly less color information than, say, DVCProHD or standard PAL.
As well, slowing video won't create the "24-frame" look. That look is created when you first capture the
image, not by slowing it down. Finally, even if you slow it down, you still need to play it at 25 fps in order to
view it on any PAL monitor.
In other words, you can't get there from here.
[ Go top ]

Firewire to Monitor Drop-outs

Jacob Hodgman, from Adelaide, Australia, writes:
We have had a recurring problem where our external video output from FCP starts to get
glitchy and then the external monitor drops out altogether. We used to try restarting/
refreshing video connections, with mixed results. We were starting to think it was a problem
with the Firewire cable itself. Until this morning.
We have 6 external hard drives running through 2 Firewire hubs attached to the Mac, with
the Firewire cable from our DV deck also running into one of the hubs.
We had 4 drives into one hub and 2 into the other. The Firewire from the DV deck was
running into the hub with 4 drives attached.
Swapping it to the hub with only two drives attached has solved our problem.
Obviously there is some kind of bandwidth/congestion/info overload going on, so I would
suggest keeping the external output Firewire connection on a hub with as little other info as
possible, to maintain a good output.
Hope this helps someone!
Larry replies: A very cool tip. Thanks!
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Audio Normalization
Dave Chalmers, from Edinburgh, writes:
You mention the use of normalization (or normalization as you would say) and I often use
STP to normalize audio clips for podcasts etc. However I have also had great success using
the 'Adaptive Limiter' plugin in STP to boost the levels, but protect against clipping at the
same time. It would be great to do a quick tutorial on that plugin in STP.
One note of caution. If you apply this effect plugin to a whole clip as a realtime effect using
the inspector, then select 'bounce to action' STP will crash. (or at least my copy does!!).
However if you select PROCESS...EFFECTS....DYNAMICS and apply it directly to the clip
that way it works fine. Go figure!
Larry replies: Dave, I am a huge fan of using Limiters, rather than normalization -- though I tend to use the
Limiter, rather than the Adaptive Limiter, because it is simpler and provides greater control over output
level.
I just wrote a tutorial on how to use the Limiter for Edit Well (click here to get your free first issue) and hope
to cover more of the audio filters there as well.
[ Go top ]

Comments on HDV
Eric Wenocur, from Lab Tech Systems, writes:
I'm an engineer currently wrangling with the whole HD transition, which includes lots of
people running around thinking it's so amazing that they can shoot *HD* for so little money!
I'm glad you chose to bring back some realism to the subject.
[ Regarding you comment about HDV shooting 1440 x 1080, ] Note that some other
"professional HD" formats, such as HDCam, also shoot in 1440. The general consensus I
have gathered is that the subsequent up-sampling to 1920 is not a big problem (although it
still ticks me off).
There is also the issue of the imager size. Lots of people are buying these teeny-tiny HDV
cameras with 1/3" imagers. This can be a problem shooting at high F-stop settings because
of diffraction limiting resolution (see link below). There are also problems with sharpness
because less light is captured, and depth of field may be too large for some applications. At
least I think that's the gist--camera optics are not my area.
http://www.tvtechnology.com/features/Masked-Engineer/f_mario_orazio-08.17.05.shtml
Heavy compression [in HDV] is also prone to more artifacts when any changes are made to
the image (dissolves, compositing, etc.) and in many cases video goes through several
stages of compression/decompression into different formats as it moves from acquisition to
delivery.
Larry replies: These are all good comments. Keep in mind that we are all still discovering what HDV can,
and can't, do. It certainly isn't a perfect format. But, if you understand it's limitations, it can be a very
inexpensive way to make the step up to HD.
[ Go top ]

Compressing HDV, H.264 and MPEG-2
Daniel Yu writes:
I thought I'd share the results of my experiments. I took a 4 minute HDV timeline in FCP5,
and first converted directly to MPEG2 using Compressor (high quality 16:9 setting). Next I
tried the H264 export. The first thing I found is that if I used "Quicktime conversion" in FCP
to convert to H264, the aspect ratio never comes out right. The picture looks "squished", like
it was anamorphically squeezed. I tried the 720x480 size, and it distorts the aspect ratio
(squeezed, rather than just a 16x9 image letter-boxed into a 4:3 frame). So instead, I used
Compressor to create the H264 clips (similar to the workflow for creating what DVDSP calls
"HD-DVDs"). As I have read, this process is VERY time-consuming. It took 12 hours (on a
dual G5) to compress 4 minutes of video! But the result looks good, perfect aspect ratio, no

distortion. I then put this H264 clip back into Compressor, and repeated the MPEG2 export I
had done earlier. Now I created a new DVDSP project with just these two clips, and then
burned a DVD, so that I could compare the two videos on a broadcast monitor.
So here's the punch-line. I scrutinized both clips very carefully. Now granted, the clips didn't
have much movement in them. But after multiple viewings, I really can't tell them apart. I
tried looking at the files themselves at full screen on a 23-inch Cinema Display and couldn't
see any significant differences. I do have to say though, that the clips look pretty darn good,
considering they are SD.
So this reassures me in some ways. The H264 process is WAY too time-consuming using
Compressor at least (3 hours per minute of video!). So I'm happy that I will not plan to do
that again.
Larry replies: One of the benefits of upgrading to the version of Compressor shipping with Final Cut Studio
5.1 is much faster performance, according to Paul Saccone. This is a good illustration of why better
performance is so necessary.
[ Go top ]

Recording on a Firestore deck
Daniel Kohl writes:
Your news letter is the best thing ... since I don't know what. I just wanted to ask you about
some thing you suggested in last month's newsletter:
"Here's another interesting idea. The Canon XL H1 has an HDSDI port on the camera. If you
record to a hard disk, such as the FireStore, ..."
Which FireStore can capture HDSDI? You might want to clarify that.
Larry replies: Focus Enhancements showed it at NAB. It's the Firestore FC-C and it's scheduled for release
in Q3, 2006. (http://www.focusinfo.com/)
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More compression problems
Beau Leland writes:
Just read over your article on the hazards of using a 2-pass encode using compressor two.
Very interesting, but I experienced something maybe even stranger. I had a sequence in my
timeline where a piece of footage is playing and then it freeze frames at a particular point so
that I could put in a super over this still frame of the footage. In the timeline, it is perfect.

However, when I exported using compressor (before I read your article) using a 90 min 2pass 16:9 setting, my freeze frame had shifted to an entirely different frame! I double
checked my timeline to see if it was my error, but sure enough it was correct in my FCP
timeline. I should also note that in addition to a 2-pass, I had also exported a QT movie
within Final Cut, and that one was correct, and so was a 90 min 2-pass 4:3 version I did. So
this problem was unique to the 2-pass 16:9 compressor version. Any idea what’s up with
that?
Larry replies: I really DON'T like exporting using Compressor. It seems to cause far more problems than it
solves. I always recommend first exporting as a QuickTime movie, then compressing the QuickTime. Much
faster and much more reliable.
Here's an article that covers this in more detail.
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Crashing in FCP 5
Pat Berning writes:
I'm using FCP5 and having a lot more crashes than with FCP 4.5, usually accompanied by
some clip becoming heavily "pixelized". I'm running on Panther OSX 3.9. on a G5. I have
tried trashing preferences but it does not help. Will Tiger sort this out or is it something else?
Most frustrating.
[Then a few hours later, Pat reported back in] Just a little update. Someone suggested that
the problem was corrupted render files and I also noticed that the pixelizing occurred at the
end of some of the clips that I had faded with the pen tool. Resetting the fade removed the
pixels and trashing the render files has left me with a few hours of work without a problem…
so far.
Larry replies: Deleting render files when you are having playback problems and re-rendering is a very good
idea -- and one that I wanted to share with other readers.
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Displaying timecode
Steffie Prietzsch writes:
Is there a way to display the current time code of a timeline sequence on an external
monitor ? (So the client can see where we are in the story). When I edit with clients who are
used to an analog set up, they always ask for this. Of course we have established a
workflow in which I tell them the TC, i.e. at the start and end of interviews, but it's tedious.
Larry replies: There's no way to display sequence timecode on an external monitor using DV, without first

adding a Timecode filter and rendering your sequence.
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A countdown clock
Ed Kaufholz writes:
For the person looking for a countdown clock on screen, it's a $10 plug-in that should work:
http://www.digital-heaven.co.uk/fcplugins/dh_counter.php
Larry replies: Thanks!
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Setting computer monitor gamma
Carl Bradshaw writes:
I have been reading through a few articles on your site, as I have been researching gamma
settings for my Apple Cinema Display (23") today. In particular, your article describing
preparation of Photoshop images recommends:
... then, as a last step, open the Levels adjustment in PhotoShop or PhotoShop Elements
and set the gray setting to 1.2. This darkens your image to match the standard video setting.
Would this assume a 'Mac default' system gamma of 1.8?
I ask because I am trying to determine if there is greater benefit in having my system gamma
set at 2.2 or 1.8. The Mac OS X monitor calibration assistant mentions 2.2 as 'TV gamma',
and recommends setting the 2.2 target if the destination is for video/TV. Is there any benefit
in keeping the old 'print' gamma of 1.8, when I use the Mac almost exclusively for Final Cut
Pro? I fully understand that a calibrated external TV/monitor is the only real acid test of the
output image, but I am trying to decide if the 2.2 OS monitor setting gives me a closer
approximation of the final result, for rough cut editing.
So, do you use 2.2 or 1.8 as your OS X gamma target?
Larry replies: 2.2 is the gamma setting that most closely matches video. My illustration assumed the
standard Mac gamma of 1.8. My system is set to a gamma of 2.2. (See my earlier article on how video and
computer images are different.)
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Weird, but it works
Mark Palmer writes:
You might already know this but i discovered that when i bring in a dvcpro 50 native file and
but it on my time line in a dvcpro 25 the render bar turns orange and when i play it -- smooth
as ice no drop frames and i can see it on my NTSC monitor running through my XL1S -poor mans way of monitoring dvcpro 50 with a dv time line--works great.
Larry replies: Weird. Interesting, but weird.
[ Go top ]

Empty Render Manager
Todd Burns, from Cincinnati, writes:
Hi Larry, I'm a former "Final Cut" student of yours (Santa Monica 4/2004). My question?
When I go to Render Manager it's totally empty? There should be tons of renders in there...
but there aren't any. Any help would be greatly appreciated...
Larry replies: Sounds to me like you've changed the location of your scratch disks. FCP's render manager
only tracks files in the current scratch disk location.
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Two-color scrolling text
Paul Delcour, from Hilversum, The Netherlands, writes:
just read your tips on the scrolling text in colour. One problem: it only works with single lines.
As soon as I have say two editors, things get out of line. Any suggestions? Otherwise
Livetype? But that program is so painstakingly slow. I use a G4 2 x 1,25GHz with 2 Gb ram.
Larry replies: Yup, just put in an extra carriage return in the text on the side that DOESN'T have the extra
line so that text stays aligned. It's a bit of extra work, but it solves the problem.
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DVD Studio Pro trick

John Warner, from Asheville, NC, writes:
While reviewing your DVD Studio Pro 3 training DVD, I have discovered that on large
projects (video of one hour or more), the storage requirements are typically at 4 gigs (as
viewed in the disk meter) and double when you then drag the video track from assets to the
menu to create the chapter index.
There is a better way. Instead, grab the track within the Graphical Window and hold it until it
ghosts then move it over to the main menu. Hold until the drop down menu offers the choice
for build chapter index. This technique will only add a couple of hundred megs to the overall
project memory vs the doubling of memory (to nearly 8 gigs) if you had dragged the video
track from assets to the menu to create the chapter index.
Larry replies: Cool.
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Looking for a Combo Deck
Wayne Houchin writes:
I am an independent editor and am looking for a good deck. I shoot MiniDV & HDV & edit on
a Mac. Do you have any suggestions?
Larry replies: At this point, in order to be sure your HDV video will play, you need to buy an HDV deck from
the same manufacturer as your camera. There are way too many reports of inability to playback when
mixing decks and cameras between manufacturers. Most HDV decks will also play MiniDV tape -- but not
necessarily DVCAM or DVCPRO-25.
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Converting 16:9 to 4:3
Raul Portillo writes:
Hello Larry, I've seen you at LAFCPUG a couple of times and I just wanted to thank you for
your great advice and knowledge.
We just tried the new Panasonic AG-VHX200, we shot on HD 720p30 that is 16:9 but I also
need to output to 4:3 (not letter-boxed, I'm OK with losing the sides), can this be done in
Final Cut?
Larry replies: Yes. Here are the steps:

●
●
●

Create a nest of your finished sequence (Sequence > Nest Items )
Load that nest into a new 4:3 sequence
Option+double-click the sequence to open it into the Browser and zoom it to 135%.

You now have a centered 4:3 picture from your sequence, ready for output.
[ Go top ]
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